      [image: image1.png]



Power Translator 15
User Guide
Language Engineering Company, LLC
215 Washington Street
Belmont, Massachusetts 02478 USA
info@lec.com
www.lec.com 

© Copyright 2003 - 2011 Language Engineering Company, LLC
Power Translator 15 – User Guide 

[image: image2.jpg]



Contents

About LEC products  .....................................................................................................................5
System Requirements......................................................................................................................6
Obtaining Support...........................................................................................................................6
Text-to-Speech and Speech-to-Text …..………………………………………………………….6
LEC Translation Bar ...................................................................................................................... 7
Using Hover Translation and Text Capture ………………………………………………………7
ClipTrans ™:

Basics............................................................................................................................. 8
Using ClipTrans ™ ........................................................................................................8
Language Pairs ...............................................................................................................9
Translation Options.........................................................................................................8
ClipTrans – Settings .....................................................................................................10
LogoTrans™:
Basics............................................................................................................................10
Using LogoTrans™ ......................................................................................................10
Translate Back ..............................................................................................................11
Language Pairs .............................................................................................................12
Translation Options.......................................................................................................13
LogoTrans – Settings ...................................................................................................15
TransIt™:
Basics............................................................................................................................16
Using TransIt™.............................................................................................................16 TransView.....................................................................................................................17
Language Pairs..............................................................................................................17
Translation Options.......................................................................................................18
TransIt - Settings ..........................................................................................................19
MirrorTrans™:
Basics............................................................................................................................21
Using MirrorTrans™....................................................................................................21
Language Pairs............................................................................................................22 Translation Options......................................................................................................22 MirrorTrans - Settings ..................................................................................................23
FileTrans™:
Basics ......................................................................................................................... 25
Using FileTrans™.........................................................................................................25
Choosing File Types.....................................................................................................27
Language Pairs............................................................................................................28 Translation Options.......................................................................................................28
FileTrans - Settings.......................................................................................................29
FileTrans - Status Bar...................................................................................................30
Dictionary: 

Basics............................................................................................................................31
Opening and Closing Dictionaries ...............................................................................33 
Looking up a Word or Phrase ......................................................................................33 

Text Translation from other programs......................................................................................... 35 

From Microsoft Word, Excel, Power Point or Outlook    ............................................35 
From Internet Explorer..................................................................................................36 

Online Translation....................................................................................................................... 36 

Translate DotNet.......................................................................................................................... 36 

Authentication ............................................................................................................36 Registration...................................................................................................................36 Subscription .................................................................................................................37 Typing Text..................................................................................................................38 Miscellaneous ............................................................................................................38 Network.........................................................................................................................38 Host ............................................................................................................................39 Authentication . ............................................................................................................39 

Language Pairs.... .........................................................................................................40 Fonts..............................................................................................................................40
Updates .........................................................................................................................40 

[image: image3.png]



Based on machine translation technology used by over three million customers worldwide, LEC’s products offer easy access to Arabic, Chinese, English, French, German, Hebrew, Indonesian, Italian, Japanese, Korean, Pashto, Persian, Polish, Portuguese, Russian, Spanish, Tagalog, Turkish,  Ukrainian and Urdu. The languages you can translate depend upon the package you have purchased. 

If you can type, paste, drag or open a file, the world's leading languages are now at your command! Translate gives you instant access to foreign-language information, while automatically translating your own documents with more accuracy, clarity, and readability than ever before. It offers powerful, user-friendly features that help you find the right words every time. 
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  LEC Translate
 Translate uses seven user interfaces: Hover Translation, LogoTrans™, MirrorTrans™, TransIt™, ClipTrans, Dictionary, and FileTrans™. 
Each application is designed to meet different translation needs. 
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  HoverTranslation translates text by your cursor. Select HoverText,HoverWord

or Translate Selections from the menu, or simply click on the HoverTranslation icon

(right click to bring up a menu to choose the type of Hover Translation).Turn Hover

Translation off by selecting its menu again or by clicking on its icon.
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  ClipTrans™  automatically translates text that is put onto the clipboard, displaying the original contents in the source pane, and the translation in the translation pane.
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 Dictionary™ lets you view the contents of System, Subject or Technical, and User Dictionaries. Depending upon the package you have purchased, you may also use the LEC Dictionary to create and edit User Dictionaries.
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  FileTrans™ generates batch translation of files or folders, including HTML. Drag a file or directory icon into the FileTrans window and the translation is automatic. You can even select which file types are to be translated, copied, or ignored. 
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 LogoTrans™ provides instant translation of text placed into the translation area. You don't even have to click a button. 
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 MirrorTrans™ replicates any window1on your desktop in another language in real time. Any application that supports standard window's messages will be supported. 
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 TransIt™ creates instant translation as you type. When you work with instant messages, chats, emails and forms, simply type in your language and have it inserted in another. 
About LEC products 

LEC provides individual translation engines for English <> Spanish, German, French, Italian, Portuguese, Russian, Polish, Ukrainian, Japanese, Chinese, Korean, Arabic, Hebrew, Persian, Turkish; Spanish <> Italian, French; German <> French, Italian; Urdu, French <> Italian. Other language pairs use a two stage translation process with English as an intermediate between the source and target languages. There are currently 340 language pairs overall. The language pairs you can translate depend upon the particular package you purchase. 
To increase translation quality in special fields, Technical Dictionaries are available for Accounting, Aerospace, Agriculture, Architecture, Automotive, Aviation, Banking, Biology, Biotechnology, Business, Chemical, Chemical Engineering, Civil Engineering, Computer, Earth Science, Ecology, Economy, Electrical Engineering, Energy, Finance, Geology, Legal, Marine Technology, Materials Science, Mathematics, Mechanical Engineering, Medical, Metal Engineering, Microelectronics, Military, Oil/Gas, Patents, Physics, Sociology, Space Exploration, Telecommunications, Urban Engineering, and Zoology (in Pro Edition only). 
Plus
• Read the online help for tips and suggestions 

• Select the appropriate fonts for each language 

• See accents, special characters, and punctuation displayed correctly. 

Fast 

For instant translation of a document, email, web page or message, you don't even have to click a button. Just cut and paste any text for automatic translation. 
Easy 

If you use Word, Outlook, Excel or PowerPoint, a Translate menu is added to the menu bar. If you use Internet Explorer or Firefox, a LEC toolbar appears in the menu bar. 
Simply select the language you want for the document you are viewing, then choose the Translate option. If you want to translate large files, websites or multi-document folders, the drag-and-drop feature lets you to translate the entire content into the language of your choice. 
High Quality 

The best automatic translation available, LEC Translate features customized translation engines for each language so you'll get understandable, usable translations for an infinite number of sentences. 
Flexible 

Create personal dictionaries of your own terms and translations. Then access them, along with the specialized LEC dictionaries, through a single, consistent interface. 

System Requirements 

Windows® 98, ME, 2000, XP or Vista™
Collins Dictionary functions only under Windows 2000,  XP and Vista. 

Disk space can exceed 1GB depending on the number of language pairs you install. Check the package for the requirements for your product. 
Obtaining Support 

Support for our product can be obtained by the following email address: 

info@lec.com
Text-to-Speech and Speech-to-Text

LEC LogoTrans supports speech input and output. To hear the text translated by LogoTrans, select “Text-to-Speech” from the Tools menu. Speech output is supported for English, French, German, Italian, Portuguese, Spanish, Dutch, Japanese, Korean and Russian languages. In addition, if you purchase and install voices for other languages, they will be automatically supported as well.

Speech dictation requires that you install a microphone to your system. It is also highly advised that you first train your computer for your voice by going to the “Speech” control panel. Speech dictation is only available for the language your computer displays menus in – the “display language”. You can change the display language by going to the “Regional and Language Options” control panel. If you select a display language for which speech recognition is supported by the operating system, then it will automatically be supported in LEC LogoTrans. 

Windows XP supports speech recognition for Simplified Chinese,  English, and Japanese. Vista supports speech recognition for many languages, but you need to have the appropriate display language installed. Vista users who do not know how to install additional display language support should read http://windowshelp.microsoft.com/Windows/en-US/Help/35a1b021-d96c-49a5-8d8f-5e9d64ab5ecc1033.mspx.
Note: speech is only supported for Microsoft XP and Vista operating systems
Limited Users will have only English speech available. 

Text-to-Speech works the same for Vista and XP operating systems, although some voices are superior with Vista OS. However, there are important differences in Speech-to-Text between the two operating systems. 

XP
You turn Speech-to-Text on and off in Windows XP by selecting "Speech-to-Text" from the Tools menu. Your dictation will then be recorded. 

Vista
Speech-to-Text under Vista is full of powerful features. You turn Speech-to-Text on and off from the Speech Recogition Control provided by Microsoft, which you can launch from the "Speech Recognition Options" control panel. For a full description of what is available, see the "Speech Recognition Options" control panel, or read Microsoft's speech documentation A quick walk-thru is also available here 

LEC Translate Control Center 

The LEC Translate control center provides rapid access to the other available programs, and can be used for translation of small amounts of text that you type directly into the program.
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To launch the other applications in the translation suite, click on their Quick Launch icon. You can translate small amounts of text by typing into the text translator pane and then hitting the Enter key, or choosing "Translate" from the menu. The menu icon lets you configure the Translation Bar and set options used throughout the translation suite. 

For up-to-date information about all Language Engineering translation products and services, visit http://www.lec.com/. 
[image: image13.png]


  Using Hover Translation and Text Capture

LEC Translate lets you easily translate small amounts of text in any program simply by moving your mouse. You select hover translation by choosing “Hover Text”, “Hover Word” or “Translate Selections” from the menu. Or you can simply click on the Hover Translation Icon (a right mouse click will bring up a menu letting you choose the type of hover translation you want to use). You can turn off hover translation by selecting the menu icon a second time or clicking on the Hover Translation Icon.

There are three ways to use Hover Translation within LEC Translate:

Hover Text: if you move the mouse over a sentence in any program, a translation of the sentence will appear in a small window beneath the cursor after a brief pause

Hover Word: if you move the mouse over a word in any program, a translation of this word will appear in a small window beneath the cursor after a brief pause

Translate Selections: if you select text in any program, a translation of this text will appear in a small window beneath the selected text after a brief pause

LEC LogoTrans lets you quickly grab text from any program and automatically translate it. You select Text Capture from the Tools menu in LogoTrans by choosing “Capture Text at Cursor”, “Capture Word at Cursor”, “Capture Text in Rectangle” or “Translate Selection”. You can then click or drag the mouse in any application and the text you click on will be automatically imported into LogoTrans, for editing and translation. You can also use Text Capture by clicking on the Text Capture Icon in LogoTrans, and turn on or off Translate Selections by clicking on the Translate Selections icon.

There are four ways to use Text Capture witnin LEC LogoTrans:

Capture Text at Cursor: if you click the mouse on text in any program, the sentence clicked on will be imported into LogoTrans.

Capture Word at Cursor: if you click the mouse on text in any program, the word clicked on will be imported into LogoTrans.

Capture Text in Rectangle: if you drag out a rectangle in any program, the text within the rectangle will be imported into LogoTrans.

Translate Selections: as you select text in any program, the selected text is automatically imported into LogoTrans. Translate Selections remains in effect after you select it until you turn it off by selecting the menu item or click on the Translate Selections icon a second time.
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 ClipTrans ™ - Basics
Use LEC ClipTrans to translate text from any program that supports copying to the clipboard. It is particularly useful when you want to translate a portion of a document or an e-mail.
Using ClipTrans™ 
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LEC ClipTrans will translate text from any program that supports copying to the clipboard. LEC ClipTrans automatically translates text that is copied to the clipboard. The original content is displayed in the source pane of the LEC ClipTrans window (top), and the translation is shown in the translation pane (bottom).
Language Pairs 
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Translation Languages Pair Chooser 

The Translation Languages Button, shown above, lets you see and control which language pair you are translating with. It shows a two letters, an arrow, and two more letters. The first letters refer to the source language and the second letters to the translation language. 

En->Fr, for example, is shown if you are translating from English to French. If you hover over the Translation Languages Button, a full textual description of the language pair is shown. 

Clicking on the Translation Languages Button displays a menu from where you can choose a different translation language. This menu is a simple listing of language pairs if you have chosen a subset of the possible language pairs. If you chose to display all or most of the possible language pairs, they will be sorted by source language. You can control the contents of this menu as shown in the Options dialog below. 
Translation Options 
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If you click on the Language Pairs chooser button, it will drop down a menu as shown above. From here you can choose the various language pack that you need to use for translations. 
In the Translation Options dialog, you can customize how translations are done. The number of available settings varies based on the language pair you have chosen and the product or subscription you have purchased.
ClipTrans - Settings 
Set options that apply only to LEC ClipTrans from the Miscellaneous tab of the Tools/Options menu.
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Bring window to front when the clipboard changes 

If this option is checked, LEC ClipTrans will pop up in front of all other applications when you copy text to the clipboard. Unless you have just copied text to the clipboard, the ClipTrans window will be minimized so that it does not get in the way of your work on other programs. 

Show Network Log when error reported 

Check this option to automatically show the Network Log whenever a network error occurs. For more information, see Network Log. 

Show Network Log when warning reported 

Check this option to automatically show the Network Log whenever a network warning occurs. For more information, see Network Log. 
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 LogoTrans™ - Basics 

LogoTrans is primarily used for quick translation of smaller quantities of text that you type directly into the program, although it can also be used to translate small text files or text that has been cut and pasted in. If you wish to translate larger amounts of text, you may want to consider using FileTrans instead. If you wish to translate HTML documents (web pages), either FileTrans or MirrorTrans may be used. 

Using LogoTrans™ 
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Typing or dropping Text 

Type or paste text into the upper pane of the LogoTrans window, this pane (known as the source pane) is colored white. Translation starts as soon as you stop typing/pasting or when you choose the Translate command. You can add to or edit the text you have entered; LogoTrans rapidly detects the change and re-translates the contents of the window immediately. You can monitor the progress of your translation and fix any problems with the translation from the status bar. 

For up-to-date information about all Language Engineering translation products and services, visit http://www.lec.com/. 

Files 

You can translate text files using LogoTrans. This is only suitable for smaller files of 2 to 3 pages or less. To translate a file choose “Load Source” from the File menu, an “Open File” window will appear letting you choose a text file to translate. 

At the bottom of the window is a box labeled “Code Page”. This box lets expert users override the default code page and specify a different code page that the text file they wish to have translated was written in. 
Automatic Translation 

The description of how to translate under “Typing Text”, “Dropping Text” and “Files” assumes that you have automatic translation turned on. When you are using automatic translation, LogoTrans monitors the source window and starts to translate whenever the source text changes. However, there are occasionally times when you may want to control when LogoTrans begins translating. You can switch to manual translation by choosing “Options…” under the Tools menu, navigating to the “Miscellaneous” tab and unticking the box marked “Automatically translate source text on the fly”. When you have turned off automatic translation, a new item is added to the “Tools” menu named “Translate”. LogoTrans will translate the source text only when you choose the “Translate” menu item (or type Ctrl-T). 
Translate Back 
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The Translate Back feature shows a re-translation of the translated text in the original language. Translate Back is a tool for judging the readability of your translation. Thus, the text displayed in the Translate Back window has been translated twice. If the results in the Translate Back window are understandable, even if the results are far from elegant, you have good reason to think the first translation is reasonably accurate. You may choose to simplify the wording or sentence structure of your source text, to see if that improves the readability of the results in the Translate Back window. 
Showing the Translate Back window 

To display the Translate Back window, select “Translate Back” from the Tools menu.

Hiding the Translate Back window 

You can hide the Translate Back window by clicking on its close box, or by unticking 

“Translate Back” on the Tools menu. 

Language Pairs 
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Translation Languages Pair Chooser 

The Translation Languages Button, shown above, lets you see and control which language pair you are translating with. It shows a two letters, an arrow, and two more letters. The first letters refer to the source language and the second letters to the translation language. 

En->Fr, for example, is shown if you are translating from English to French. If you hover over the Translation Languages Button, a full textual description of the language pair is shown. 

Clicking on the Translation Languages Button displays a menu from where you can choose a different translation language. This menu is a simple listing of language pairs if you have chosen a subset of the possible language pairs. If you chose to display all or most of the possible language pairs, they will be sorted by source language. You can control the contents of this menu as shown in the Options dialog below. 
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The Language Pairs panel lets you choose which translation pairs to display in the Translation Languages button on the Status Bar of the application. You can choose to have all possible language pairs (well over one hundred) displayed, or prune the list to display only pairs that contain a particular language, or select the exact list of pairs you wish to have displayed. 

Translation Options 
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If you click on the Language Pairs chooser button, it will drop down a menu as shown above. From here you can choose the various language pack that you need to use for translations. 
Clicking on the "Translation Options" menu will open the following window: 
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Based on the type of subscription you have, you can choose which dictionaries are used for the translations. The dictionaries tab is common for all the language pairs. 

The other two tabs (Input, Output) differ depending upon languages chosen. Based on your language preferences, you can set the various tabs for the settings you require. 
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LogoTrans - Settings 
Clicking on the "Options" button will open the Options window. Selecting the "Miscellaneous" tab will let you set options that apply to LogoTrans-only. They are as follow: 
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Automatically translate source text on the fly 

Select this option to turn on automatic translation. 
Show Back translation 

Select this option to show the Back translation window. 
Show Network Log when error reported 

Select this option to automatically show the Network log window whenever a network error occurs. 
Show Network Log when warning reported 

Select this option to automatically show the Network log window whenever a network warning occurs. 
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 TransIt™ - Basics 

TransIt allows you to quickly input text in a language that is familiar to you, but is not your native language. It is designed to work with any programs that accept text entry. 

For example, you can use TransIt to specify search text in an Internet browser or to help you reply to email from another country. 
The TransIt window has an area on the right for entering text. Simply type or paste the text in, press the <Enter>  key to have it translated. You may then edit the result if you wish, and press <Enter> again to put the translation into your application at the cursor. 

Using TransIt™ 
Pushpin Network Menu Text 
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Window Chooser 
Language pairs chooser button 
TransIt can be controlled and configured by using the series of icons to the left of the text area. You can have up to five icons visible: the Pushpin, Window Chooser, Network, Translation Language Pair Chooser, and Menu icons. You can hide any icons you do not need, either from the menu or from the Miscellaneous Options tab. 
Pushpin 

When the pushpin is down, TransIt stays at a fixed location on the screen. It remains a fixed width, although it will grow taller as needed to accommodate any text entered into the text area. You can reposition or resize the window as you required. Alternatively, you can remove the pushpin and TransIt will freely reposition itself on your screen to a location that is close to the window to which it will send translated text. 

When the pushpin is up, TransIt will minimize whenever it is not the front-most window. 

This setting is most useful in conjunction with setting a Hot Key, which lets you quickly bring up TransIt from within any application you are running. If you hide the pushpin, you can still change the pushpin setting with the "Window remains at fixed location and width" setting on the Miscellaneous Options tab. 

Window Chooser 

You can use the Window Chooser icon to change the application (called the target application) to which TransIt sends translation. When TransIt is first launched, or is brought to the front by a hot key, it tries to target the front-most application. You can change the target application by dragging the window chooser icon to a different window. TransIt will then attempt to target that window. Clicking once on the window chooser icon makes TransIt target the front-most window. 
Send Translation to 'xxx' 

You can view this item in the menu by right clicking on the application or clicking on the "Menu" link button. This menu item only appears when you have translated text in the text area. 'xxx' is replaced with the name of the target application. The Enter key can also be used as a faster way of sending the translated text. 
Clear Translation 

This menu item only appears when you have translated text in the text area. It removes the translated text. The escape key can also be used to clear the translated text. 
TransView 

The TransView window translates text in the opposite direction from the translation languages set in TransIt. For example, when TransIt is set to translate from French to English, TransView translates from English to French. 

TransView automatically monitors the text on whichever window TransIt is targeting. The translation occurs automatically. TransView can monitor most applications that accept text entry, such as Notepad, WordPad and most chat and instant messaging software. 
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Language Pairs 
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The Language Pairs button functions in the same way for each application launched by Power Translator 15. 

For more details, see the Language Pairs section p.10. 
Translation Options 
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If you click on the Language Pairs chooser button, it will drop down a menu as shown above. From here you can choose the language pack that you need to use for translations. 

Clicking on the "Translation Options" menu will open the following window: 
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From here, you can choose what dictionaries are used for translations based on your subscriptions. The dictionaries tab is common for all of the language pairs. 

The other two tabs (Input, Output) are different for different languages. Based on your language preferences you can set the various tabs as you require. 
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TransIt - Settings 
Right clicking on the application will show the menu. 
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Clicking on the "Options" menu will open the Options window. Selecting the "Miscellaneous" will let you set options that apply to Transit only. They are as follow: 
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Window remains at fixed location and width 

This sets the pushpin status of the application. For more details, see the explanation of the pushpin. 
Show TransView Window 

Show or hide the TransView window. This can also be done from the menu. 
Animate committing translation 

When turned on, a short animation runs showing where the text from TransIt is being sent. This can be helpful if you find the translated text is not showing up where you expect it, which is often due to selecting the incorrect target application. 
Pick which icons will be displayed 

You can control which icons you want shown in TransIt. The window automatically grows or shrinks for the number of visible icons. This can also be done from the menu. 
Show Network Log when error reported 

Select this option to automatically show the Network log window whenever a network error occurs. 
Show Network Log when warning reported 

Select this option to automatically show the Network log window whenever a network warning occurs. 
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 MirrorTrans™ - Basics 
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MirrorTrans translates the entire contents of an application's window, automatically responding to changes made to the text. No commands are needed - the translation happens automatically and instantly. 

Using MirrorTrans™ 
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You can use the Window Chooser icon to change what application MirrorTrans translates (called the target application). When MirrorTrans is first launched, or is brought to the front by a hot key, it tries to target the front-most application. You can change the target application by dragging the window chooser icon to a window. MirrorTrans will attempt to target that window. Clicking once on the window chooser icon makes MirrorTrans target the front-most window. 
Automatic Translation 

When green, MirrorTrans continually monitors the text in its target window and re-translates whenever that text is changed. If automatic translation is red, it will show the target window's contents, but will not translate the contents. 

Target 

Displays the name of the application window that MirrorTrans is currently targeting. 
Progress Indicator 

The progress indicator shows you how near completion the current translation is. It is empty if no translation is currently running. 
Translation Status 

The Translation Status indicator will show either “Idle” or “Translating”, depending on whether a translation is currently running. It may also show “Error” if a serious problem occurs with attempting the translation. 
Language Pairs 
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The Language Pairs button functions in the same way for each application launched by Power Translator 15. 

For more details, see the Language Pairs section p.10. 
Translation Options
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If you click on the Language Pairs chooser button, it will drop down a menu as shown above. From here you can choose the language pack that you need to use for translations. 

Clicking on the "Translation Options" menu will open the following window: 
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From here, you can choose what dictionaries are used for translations based on your subscriptions. The dictionaries tab is common for all of the language pairs. 

The other two tabs (Input, Output) are different for different languages. Based on your language preferences, you can set the various tabs as you require. 
MirrorTrans - Settings 

The "Miscellaneous" tab from the "Options" menu, lets you set options that only apply to MirrorTrans. 
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Window should float above all applications 

When selected, MirrorTrans will be the front-most window unless it is minimized or hidden. 
Show Menu Bar 

When you choose not to show the menu bar, you can still access the menus by right clicking within MirrorTrans. 
Show Automatic Translation Button on Status Bar 

If Automatic Translation is not a feature you use regularly, you can save space by not including it on the menu bar. It can still be turned on or off from the menu. 
Show Network Log when error reported 

Select this option to automatically show the Network log window whenever a network error occurs. 
Show Network Log when warning reported 

Select this option to automatically show the Network log window whenever a network warning occurs.  
Source text automatically comes from the clipboard 

When you turn on this feature, MirrorTrans stops its normal application targeting and translates the clipboard instead. This can be handy in the rare instances where an application cannot normally be targeted by MirrorTrans. To use this method, turn on the feature, go into the application containing the text you wish translated, select the required text and choose "Copy". The translation will appear in MirrorTrans. 

[image: image44.png]


 FileTrans™- Basics 
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FileTrans is the fastest and easiest way to translate one or more documents. You can drag and drop directories or files directly onto the FileTrans window, or use the Translate button to select the files you wish to have translated. Drag a file onto FileTrans and have the translated file appear automatically when it finishes. 

Alternatively, drag a directory of files onto FileTrans and have all of the files in the directory translated automatically. You can even drag text directly from your text editor and have it translated immediately. 
FileTrans can read plain text, UNICODE, RTF, PDF, XML, Word and HTML files. The translated files are created automatically. 

Text can be translated to any of a dozen languages with a single click of the mouse. You can monitor the progress of translation, and fix any problems, from the status bar. 

Using FileTrans™ 
There are several ways to translate files using FileTrans. 

1. While FileTrans is running, drag and drop one or more document files or folders onto the application window. 
2. Copy and paste or drag and drop selected text from another application onto the running FileTrans window. 
3. While FileTrans is running, click on the "Translate" button or choose "Translate File" from the menu as shown below. 
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To display the menu bar click on the "Options" button then the "Miscellaneous" tab and select the "Show Menu Bar" option. 
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4. From the desktop or Windows Explorer, drag one or more files or folders onto the FileTrans icon. 

The FileTrans window shows the number of files to be translated, the name of the file currently being translated and a progress indicator in the status bar showing the time remaining to complete the current translation. 

Click Stop to interrupt the translation process before it is complete. Only fully translated files are retained. 

When FileTrans has finished a translation, it saves the translation in the same folder as the original file. The translation file has the same name as the original, along with a prefix indicating which translation was performed. 

For example, a French translation of an English file named "mysample.txt" is saved as "en to fr translation of mysample.txt". 

Settings in Options determine whether the newly translated file should be displayed immediately, plus when the original untranslated file should be retained or deleted. 

When FileTrans has finished translating text dropped onto the FileTrans window, it opens a window (in the default text editor) containing the translated text. If you want to keep the translation, save it as a file. 

For each directory that FileTrans translates, it creates a new directory with the same internal structure - that is, the files and sub-directories are all in the same place. This new directory is labeled with a prefix to indicate that it contains translations, but otherwise all of the files have exactly the same names. 
For example, translation of a directory called "MyFiles" from English to French results in a new directory called "en to fr translation of MyFiles" containing files and sub-directories with the same names as those inside "MyFiles." Of course, the files in this new directory have been translated into French. 

Settings in Options allow you to choose which types of files are to be translated, and whether untranslated files are copied unchanged or ignored. 
Choosing File Types 
This feature lets you control which files should be translated by FileTrans and which should be ignored. You can select which file types should be excluded from the translation and also 
Procedure: 

Clicking on "Options" button displays the Options window. Selecting the "Special Files" tab will show the following window. 
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From here you can choose which files should be allowed for translation and which are to be ignored, based on the file extensions. 

The tab contains two sections, one to control how FileTrans should handle files that it cannot translate (such as pictures or data formatted in ways that FileTrans does not understand), and the other telling FileTrans what files it should treat as web pages and not as ordinary text. 

Both sections contain a list of file extensions. To add extensions to the list, type in a new extension in the text field labeled "Extension" and click the "Add" button. To remove an extension, select it in the list and click the "Remove" button. 

In the top section, which contains the list of file extensions that FileTrans should not try to translate, there is an additional tickbox that controls whether or not FileTrans should duplicate files that it cannot translate. If selected, an exact copy of the original file will be placed in the new translation folder. 
Language Pairs 
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The Language Pairs button functions in the same way for each application launched by Power Translator 15. 
For more details, see the Language Pairs section p.10. 

Translation Options 
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If you click on the Language Pair chooser button, it will drop down a menu as shown above. From here you can choose the various language packs that you need to use for translations. 
Clicking on the "Translation Options" menu will open the following window: 
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From here, you can choose what dictionaries are used for translations based on your subscriptions. The dictionaries tab is common for all of the language pairs. 

The other two tabs (Input, Output) are different for different languages. Based on your language preferences, you can set the various tabs as you require. 
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FileTrans - Settings 
Clicking on the "Options" button will open the Options window. Selecting the "Miscellaneous" tab will let you set options that apply to FileTrans-only. They are as follow: 
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Open translated file when finished 

Select this option to automatically open the translated file, after it has been completely translated. This option does not apply when translating folders. 
Discard original file when finished 

Select this option to delete the original file after it has been completely translated. This option does not apply when translating folders. 
Show Menu Bar 

Select this option to show a menu bar within FileTrans. If deselected, you can still use the context or system menu to make menu choices. 
Show Network Log when error reported 

Select this option to automatically show the Network log window whenever a network error occurs. 
Show Network Log when warning reported 

Select this option to automatically show the Network log window whenever a network warning occurs. 

FileTrans - Status Bar 
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Progress Indicator 

The progress indicator shows how near completion the current translation is. It is empty if no translation is currently running. 
Translation Status 

The Translation Status indicator will show either “Idle” or “Translating”, depending on whether a translation is currently running. It may also show “Error” if there is a serious problem with attempting the translation. 
Translation Languages Button/Language Packs Button 

The Translation Languages Button, shown above, lets you see and control which language pair you are translating with. It shows a two letters, an arrow, and two more letters. The first letters refer to the source language and the second letters to the translation language. En​>Fr, for example, is shown if you are translating from English to French. If you hover over the Translation Languages Button, a full textual description of the language pair is shown. 

Clicking on the Translation Languages Button displays a menu from where you can choose a different translation language. This menu is a simple listing of language pairs if you have chosen a subset of the possible language pairs. If you chosen to display all or most of the possible language pairs, they will be sorted by source language. You can control the contents of this menu from the Language Pair tab of the Options window. 

Dictionary 
The Dictionary is an application that lets you look up words in any dictionary. This includes the default dictionary for a language engine, technical dictionaries and user dictionaries. Depending upon the package you have purchased, you may also create user dictionaries and edit entries in them using the Dictionary. 
The Dictionary opens from within FileTrans, LogoTrans, TransIt and MirrorTrans whenever you choose to browse an open dictionary or look up words. You can also open the Dictionary from the Windows Start menu, My Computer or Windows Explorer. If you open a dictionary from Windows Explorer, the Dictionary will be launched automatically. 

Dictionary - Basics 
NavigationMenu Bar Selection Panel Details Panel Panel 

Entry Properties Dictionaries Panel Panel 
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Status Bar 
The Navigation panel on the left side of the window shows the entries found in the selected dictionary or dictionaries, arranged in alphabetical order. 
The Menu Bar at the top has five items: File, Edit, Navigation, Tools and Help. 
The Selection panel, near the top of the window under the Menu Bar, is used to search for words in the dictionaries. 
The Details panel, at the right of the window just under the Selection panel, lists details of the selected entry or entries in the Navigation panel. 
The Dictionaries panel at the bottom of the screen, just above the Status Bar, gives information about each loaded dictionary. 
The Entry Properties panel at the right of the screen below the Details panel gives detailed information about the selected entry. 
The Status Bar at the bottom of the LEC Dictionary window gives: information about network log; the number of matches found; the number of entries currently selected; the number of dictionaries currently loaded; the search status and the currently selected language pair. 
Opening and Closing Dictionaries 

The Dictionary can work with more than one dictionary at a time. The list of loaded dictionaries is shown in the Dictionaries panel at the bottom of the screen. 

When looking up a word, choose the dictionaries to be searched from among those loaded, by selecting one or more from the list box at the far right of the Selection panel. Those selected will show a tick in the first column of the Dictionaries panel. 

To load a user dictionary or technical dictionary so it can be searched, either: 
Choose Translate Options from the Tools menu 

Click on the language pair at the bottom right and select Translate Options. 

To load a dictionary, select the dictionary from "Available section" in the dictionary tab. Then click the arrow to transfer it into the "In Use section" and click OK. 

You will find all the selected dictionaries are loaded in the Dictionary. 

To unload (close) a dictionary so that it can no longer be searched, either: 

Choose Translate Options from the Tools menu 

Click on the language pair at the bottom right and then select Translate Options. 

To unload a dictionary, select the dictionary from the "In Use section” of the dictionary tab. 

Then click the arrow to transfer it into the "Available section" and click OK. 

The selected dictionary will be unloaded from the Dictionary. 

Looking up a Word or Phrase 

1. Choose the part(s) of the dictionary entries you wish to search: the source text, the translation text, or both, using the "Source" list. 

For example, suppose you have the language pair set to English to Spanish and are searching the system dictionary for that pair, with the part of speech set to "Any POS" and "Starts With" set to "Exact Match."  The search text is 'macho'. 

If you ask for "Source" you will see displayed in the Navigation panel the entry 'macho (adj)', with the Spanish translation 'machote'. 

If you ask for "Translation" you will see several entries such as 'bull (n)' and 'male (adj)' with the Spanish translation 'macho'. 

If you ask for "Both" you will see all of these. 

Note: Some translation engines do not support searches for "Translation". To see what kinds of searches, parts of speech, and dictionaries are available for the language pair you have chosen, look at the choices in the drop-down list boxes for that engine. 
2. Choose the type of search you want from the "Starts With" list in the Selection panel, just below the Menu Bar. 
• To find all entries that match the first letters of a word, choose "Starts With." 

For example, a search for 'colo' using "Starts With" would display all of the entries from 'COLO' through to 'colossus'. Alternative spelling substitutions are not allowed, so 'color' would not be displayed. 

Note that using "Starts With" will show entries that have inflected or alternate forms beginning with the requested characters. For example, if you search for 'we', the Navigation panel will display entries for 'be', which has the past tense 'were' and 'go', which has the past tense 'went', among other entries. 
•To find all entries that match the last letters of a word, choose "Ends With." 

For example, a search for words ending in 'ee' would display all of the entries from', you see' through 'absentee', 'ad hoc committee', and so forth, down to 'Yankee'. 
•To find an entry for a word that may be spelled in more than one way, choose "Rough Match." 

For example, there may be no entry for 'color' in the dictionary, but the translation system would use the definition for 'color' instead. When "Rough Match" is chosen, such substitutions are allowed. Thus, looking up 'color' would display any dictionary entries for 'color'. 
•To find adjectives with prepositions, or verbs with particles and/or prepositions, choose "Rough Match" and the relevant POS and type in the bare adjective or verb. 

For example, searching for 'sure' with "Rough Match" and "Adjective" chosen will display 'sure' and 'sure of'. Searching for 'pick' with "Rough Match" and "Verb" will display 'pick on', 'pick out', and 'pick up on', among others. 

•To find an entry that exactly matches your spelling of a word, choose "Exact Match." 

In this case, a search for 'color' would not match 'color', since no substitutions are allowed with "Exact Match". 
•To see all the entries in the selected dictionary or dictionaries, choose "All Entries." 

Note: The types of searches supported are engine specific; not all language engines support all types of searches. "Exact Match" is supported for all engines. 
3. Using the Any POS list, choose the part of speech for which to be searched. Examples: Any POS, Noun, Verb, Adjective, Adverb, Preposition, Conjunction, or Prepositional Phrase. 
Note: Again, POS is engine specific; different engines support different POS types. 

Entries marked  'Special' may be displayed when "Any POS" is chosen. These are entries that have rarer parts of speech not supported in User Dictionaries. 
4. Using the All Dictionaries list, choose the dictionary or dictionaries to be searched from among those loaded: All Dictionaries, Technical Dictionaries, User Dictionaries, or the System dictionary for the language pair you are using. Select Custom Search to ask for any combination of dictionaries not listed. 

Those selected will show a tick in the first column of the Dictionaries panel. You can also turn searching on and off for a given dictionary by clicking in this column. 
5. Type the word or phrase you are looking for in the text box in the middle of the Selection panel. 
When you pause in typing, Language Engineering Dictionaries displays a list of matching words in the Navigation panel at the left. The first item found (not necessarily the first item in alphabetical order) is selected, and one or more dictionary entries for that item appear in the Details panel just below the text box where you entered the word or phrase. 
In the Details panel, an entry may include information such as the source word and its inflections or inflection pattern, part of speech, gender, and dialect; the translation with its translation pattern, inflections, part of speech, gender, dialect, and semantic features; the dictionary the item was found in. You can choose which columns appear in this view, and change the width of the columns by dragging the column separators in the header row. You can also choose on which column the sort is performed, by double-clicking on the header for that column. 
Note: The information which can be displayed in the Details panel is specific to a particular language and language engine. 'Gender', for example, is used only by the English to Spanish engine.  'Inflection pattern' is used only by the other European language engines, and refers to the inflection class into which a given word falls. For a full explanation, see the User Dictionary Editor help for those engines. 

The number of matching entries is shown at the right end of the Status Bar, at the bottom of the window just below the list of loaded dictionaries. 

6. If more than one word matches the search, locate and select the item you want in the Details panel to display the dictionary entry in the Entry Properties pane below it. 

Text Translation from other programs 

From Microsoft Word, Excel, Power Point or Outlook 

The LEC Office Translation Addin provides easy-to-use translation capabilities to Microsoft Word, Microsoft Excel, Microsoft PowerPoint or Microsoft Outlook. It adds a translation menu to these products, that lets you select the languages you wish to use in translation and then translate either all or part of a document. 
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After selecting the language pair you require from the Language Pair menu, translate the document by choosing "Translate All". The other menu items let you get technical support, configure how translations should be performed and manage your DotNet subscriptions. 
From Internet Explorer 
The LEC Internet Explorer Translation Bar is an add-in for Internet Explorer that lets you quickly and easily translate web pages as you browse the Internet. This add-in only works on html files (web pages); for more general text translation, you should consider using LogoTrans. If you have larger files or wish to batch process multiple files at once, use FileTrans and for email or chat, TransIt will be more suitable. 
Menu Button 
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Translate Button 
Translation Languages Button )

After selecting the language pair you wish to use from the Translation Languages button, translation is completed by clicking once on the Translate Button. Every web page viewed from that point on will be translated. To switch this off, click the Translate button a second time. For other options e.g. getting help or setting translation options, click the Menu button. 

Online Translation 

Translate DotNet 
Authentication 

In order to use LEC translations, a user must be authenticated. To do this, the user must be registered, and have a subscription that covers the required languages. 
Registration 

Registration is usually completed when the software is installed. If the user has registered on the LEC website previously, the email and password used then should be used during installation. 
Occasionally an unregistered user might wish to use the LEC products after they have been installed.  To do this, the user should first make sure that the Network Options Panel is set to "Request authentication before starting translation". That will bring up the User Authentication dialog during the first translation. 
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Users who are already registered enter the appropriate email and password into the boxes provided. New users should press the "Register" button and register on the LEC website. When they have finished that registration process, they should use the password they receive by email and enter it into this window. Users only need to register once ​from then on they merely need to use the correct email and password. If a user forgets their password, they can go to the LEC website (http://www.lec.com/Login.asp) and press the "I've forgotten" button to get the correct password sent to them via email. 

Subscription 

Subscriptions allow users to translate between a set of languages. If you purchased a copy of LEC translation software, you will already be subscribed. If you download an evaluation copy of the software, you will be given a limited duration subscription to allow you to "test drive" the software. In either case, you will need to re-subscribe when your subscription has expired or when you wish to translate between languages not covered by your current subscription. When this happens, the software will launch the Subscription Dialog, to guide your choices on which subscriptions to purchase. You can also choose the "Subscribe" menu item to view all possible subscription choices. 
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You can set the subscription type and duration, view the details of what the subscription supports and the cost. If you already have a subscription, you will receive credit for your existing subscription if you upgrade to a more powerful one. When you have chosen a subscription option that meets your requirements, press the "Subscribe" button to complete the process. This will direct your web browser to the Language Engineering website to finish subscribing. If you wish to view a complete list of your existing subscriptions, press the "View Subscriptions" button (you can also do this at any time by choosing the "View Subscriptions" menu item. 
Typing Text 

Type (or paste) the text you wish to be translated into the text translation area. Untranslated text is colored black, translated text is colored blue. To translate the text, press Enter or choose “Translate” from the menu. You can edit the translation and then drag it or copy it to the clipboard for use elsewhere. If you wish to enter new text for translation, select all of the translated text and delete it, or choose “Clear Translation” from the menu, or press the Escape key. 

Miscellaneous 

The miscellaneous tab lets you set options that only apply to LogoTrans DotNet. 
Show Network Log when error reported 

Select this option to automatically show the Network log window whenever a network error occurs. 
Show Network Log when warning reported 

Select this option to automatically show the Network log window whenever a network warning occurs. 
Network 

The Network panel lets you set information about the translation server you are using, and your account information. 
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Host 
The host field specifies the URL of the translation server you are using. Normally, you will not need to change anything here as the correct value is selected automatically. 

If you wish to use a different translation server you can type the URL into the field. If your system is set up to support more than one server, you can click on the drop-down arrow to get a list of servers from which to choose. 

When you change translation servers, or if you are experiencing network problems, click on the “Test Network Connection” button to test your connection to the translation server. After a brief pause, it will report back the status of your connection to the server. 
Authentication 

User authentication is needed for all LEC Translate DotNet products. For full details, see Authentication. 
This set of options is normally set to the correct value at installation. "Server does not require authentication" is the correct setting for companies who have purchased a license to run their own translation server. It should be turned on only by the installer. The other two settings can be chosen as required by users. "Authenticate for this user" is the most convenient choice; it automatically logs the user onto the LEC site when the software is first run. If you want the software to be run by multiple users from the same machine, you can choose "Request authentication before starting translation". In this case, the first time the software is asked to do a translation, it brings up the User Authentication dialog and logs in the user. 
Language Pairs 

The Language Pairs tab lets you choose which translation pairs are displayed by the Translation Languages Button. You can choose to have all possible language pairs (well over one hundred) displayed, or prune the list to display pairs that contain a particular language, or select the exact list of language pairs you need. 
Fonts 

The Fonts tab lets you choose which font should be used by the software when displaying text in a particular language. On the left-hand side is a list of languages. Selecting any language shows the current font settings for that language. You may change the font and font size to any that support the selected language. 

When you select a language, the font and size fields may become blank. In this case, there is no font on your system that supports the chosen language. The “Install Missing CodePage” button will then become enabled, letting you update your system to support the selected language. Different versions of Microsoft’s operating system update the code pages in different ways: it may be through the control panel or through a web page. 
Updates 

The Updates tab controls how you will be notified when free updates are available. 

Normally the software checks to see whether updates are available when the program is launched. Alternatively, select the "Update only when I choose the update menu item" option to control when the software checks for updates. When an update is found, a window appears describing what new features are included. To update the software, simply download and run the installation file provided. 
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